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4.5 RETRIEVE MENU 

1. 4.5.1  about retrieve functions (general comments) 

2. 4.5.2  auto-annotate project 
3. 4.5.3  new project from genbank records 

4. 4.5.4  convert genbank ac to gi 
5. 4.5.5  entrez 

6. 4.5.6  locus link 
7. 4.5.7  import annotation from ms-file 

4.5.1 about retrieve functions 

In addition to annotation by blast searching SEQtools contains several 
functions designed to automatically retrieve sequence annotation from 

various sources. 
 

 
 
4.5.2 auto-annotate project 

With this function you can automatically retrieve sequence annotation 
(Genbank records and/or Medline) for the blast search currently selected 

as the Virtual Blast Search. As in batch blast functions you can set the 
sequence Range to current, all or selected group. 
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Tab for setting the range parameter for retrieval. 
 

 

Tab for setting lower limit (maximum expect value for retrieval of 
annotation) for retrieval. The second parameter tells the retrieval function 

to preferentially retrieve Medline information from the specified Genbank 

subsection (ALL, REF, DBJ, EMB, GB or GI) - but only if the expect value 
of the match is within the specified cutoff limit (in percent of retrieval 

expect value cutoff). 
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4.5.3 new project from genbank records 

A rather complicated function which allows you to create an entirely new 
SEQtools project composed of sequences retrieved (best matches of one 
or more specified set of blast results) from Genbank.  

 
The first step is to select the blast searches to include in the retrieval 

process. The list of available blast searches is prioritized and can be 
modified by the Up, Down and Remove buttons. Once the list is finished, 

click the Build New Gene List tab. 
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Clicking the Build List causes SEQtools to scan all header of the project for 
the information required to retrieve sequences from Genbank. The 
retrieved information is displayed in the sequence list. Use Remove 

Selected and Remove Duplicates to clean the list of sequences to be 
retrieved from Genbank. 

 
Clicking Retrieve Records launches the retrieval process. 
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SEQtools then downloads the selected sequences from Genbank. The list 

below displays the progress (and rejected sequences). The list also 
includes a short extract of the retrieved sequence. 
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When downloading is completed the Compose New Header tab is 

displayed. In this tab you can select information to be transferred from 
the current to the new SEQtools project. 



 115 

 

 

Finally click Build Annotation and save the new project as a SEQtools 

formatted multi-sequence file. Clicking Open Project With MS-File 
launches a new instance of SEQtools containing the Genbank sequences 

derived from the original project. 
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The sequence annotation transferred from the original project to the 
derived Genbank project. 
 

 

 

4.5.4 convert genbank ac to gi 

A simple translator converting a list of accession (AC) numbers to a list of 
GI numbers. 
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4.5.5 entrez 

"The life science search engine" - the key source of biological information 
at NCBI. No description is necessary, visit the site and see for yourself... 
 

 

4.5.6 entrez gene (locus link) 

The old LocusLink site has been is superseded by Entrex Gene, a 
searchable database of genes, from RefSeq genomes, and defined by 

sequence and/or located in the NCBI Map Viewer. 
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4.5.7 import annotation from ms-file 

If information relating to the same set of sequences but present in two 
different SEQtools projects (i.e., with exactly the same sequences) it is 
possible with this function to import annotation from a second project 

containing the same sequences (but with different information stored in 
sequence headers). Simply choose the SEQtools formatted multi-

sequence file and select the information you wish to import. 
 

 

In this example various user created information is available in the multi-
sequence file. 
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Clicking Transfer starts the import process, listing the number of imported 

header sections. Remember that nothing is permanent in SEQtools until 

the project is saved. There is no Redo option here so simply close the 
project without saving it to cancel the operation. 
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4.6 COMPARE MENU 

1. 4.6.1  about comparing sequences 

2. 4.6.2  compare two sequences (general) 
3. 4.6.3  compare two sequences (dot matrix) 

4. 4.6.4  compare two sequences (bl2seq) 
5. 4.6.5  alignment, clustalw 

1. 4.6.5.1    t-coffee 
2. 4.6.5.2    genedoc 

3. 4.6.5.3    tree view 
6. 4.6.6  alignment, clustalx 

7. 4.6.7  sequence merge editor 

8. 4.6.8  merge sequences, emboss 
9. 4.6.9  clustering 

1. 4.6.9.1    blast score values 
2. 4.6.9.2    blastclust program 

3. 4.6.9.3    blastn alignments 
4. 4.6.9.4    output 

5. 4.6.9.5    clustering report 
6. 4.6.9.6    deduced clone report 

4.6.1 about comparing sequences 

This menu contains a series of functions for comparing and/or aligning 
two or more sequences. Alignment is performed by ClustalW for functions 

with a SEQtools user interface. It is possible to use the facilities contained 
in the ClustalX version of the alignment program which comes with its 

own user interface - with many more options than contained in the 
SEQtools functions. 

 
SEQtools communicates to a limited extent with ClustalX (auto-exporting 

sequences to ClustalX and importing the alignment when processing is 
completed and ClustalX is closed). 
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4.6.2 compare two sequences (general) 

This compare function performs a comparison between two sequences 
selected from the project sequence list. If no sequence is selected the 
currently displayed sequence is compared with itself.  

 
The result is displayed as a sorted list of matches on the current sequence 

giving the length of identical regions and the coordinates of the regions 
on the current and the query sequence. A W indicates the match is to the 

Watson strand and a C a match to the complementary Crick strand (in 
red). Note that coordinates refer to the Watson strand of both the current 

and the query strand. Various parameters (max number and min length 

of matches) can be set on the Options menu. 
 

To get a quick overview matching (=identical) regions between the two 
sequences are displayed in a diagram with identical regions indicated in 

green (W strand) or blue (C strand). 
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Graphical overview of the sequence comparison for identical regions. 

 

 

4.6.3 compare two sequences (dot matrix) 

This function allows you to compare two sequences (nucleotide or 
protein), or a sequence with itself, using a dot matrix approach for finding 

identical regions in the two sequences (selected from the project 
sequence list) by clicking the Select command button.  

 
A matrix is built by clicking Build containing Boolean information 

(True/False) for the comparison of all bases in sequence 1 against all 
bases in sequence 2. When the matrix is complete click Filter to clean (of 

short diagonals) and display the matrix. Clicking Filter again  increments 
the minimum length of preserved matches. You can manually enter a 

value in the text field before clicking Filter to achieve the same result. The 

dot plot is scaleable. 
 

Holding down the left mouse button while searching the dot plot with the 
mouse pointer, displays the coordinates in both sequences. Releasing the 

mouse button snaps to the nearest diagonal (if you are sufficiently close 
to it) and displays the properties of the match (diagonal). 

 
For protein sequence comparisons it is possible to set and select a 

replacement scheme which causes the function to replace single character 
amino acid codes by numbers representing amino acids with similar 

properties. 
 

The different options of the dot plat function is illustrated by screenshots 
below. All examples shows a comparison of a single sequence with itself. 
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A short nucleotide diagonal detected by pointing and dragging while 
holding down the left mouse button. The diagonal is auto-detected when 

the left mouse button is released. 
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The full diagonal (perfect match of the sequence to itself) of the 

comparison. 

 

The amino acid replacement form for composing replacement schemes.  
You can create and store up to 10 different replacement schemes. Click 

Accept to use the selected scheme - and Build to see the result of the 
amino acid replacement. 
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Dot plot of an amino acid sequence compared to itself created with amino 

acid replacement activated. - The diagonal analysis window includes 
coordinates to the match as well as the replacement scheme.  



 126 

 

 

The longest diagonal from the comparison above without amino acid 

replacement. 
 

 



 127 

The same diagonal but with active amino acid replacement to highlight 

regions composed of amino acids with similar properties. 
 

 

4.6.4 compare two sequences (bl2seq) 

This function utilizing the NCBI program bl2seq allows you to compare the 
currently displayed sequence to other sequences contained in the project. 

The actual comparison is performed by blastn, blastx or blastp depending 
on the program argument of bl2seq. The SEQtools interface to bl2seq 

auto-detects the sequence type to be compared in the following way: 
 

The Subject sequence is for protein and nucleotide projects the currently 
selected/displayed nucleotide sequence. Query sequences are either the 

currently selected nucleotide sequence (in Single Search mode) or a 
selected range of nucleotide sequences included in the project (Project 

Search mode). 
 

Query = nucleotide, Sbjct = nucleotide, Program = blastn - Default for 
normal sequence projects. 

 
Query = protein, Sbjct = protein, Program = blastp - Default for 

protein projects. Options controlling upper/lower/both query strand(s) are 

disabled in this mode. 
 

Query = nucleotide, Sbjct = protein, Program = blastx - Activated 
nucleotide projects when the current sequence is translated into protein. 

The displayed translated sequence (i.e., a protein sequence) is retrieved 
directly from the main editor and used as the subject in the comparison 

with bl2seq. 
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Default blast arguments: 

  Default settings for bl2seq 

Relaxed blast arguments: 

  Cost to open a gap   = 0 
  Cost to extend a gap   = 0 

  Dropout value for gapped alignment  = 0 
  Word size    = 8 

  Penalty for a nucleotide mismatch  = -1 
  Reward for a nucleotide match  = 2 

  Other bl2seq parameters   = defaults for bl2seq 

Use the Strand options to compare the upper, lower or both strand of the 

Query sequence(s) against the Subject sequence. 
 

The output is stored in the sequence header of the query sequence(s). 
Note that you can only store the results of one comparison analysis at a 

time. Running a new bl2seq analysis overwrites existing data stored in the 
headers without warning. 
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Single bl2seq comparison of two selected sequences. 

 

 

Comparing the Subject sequence to all or a selected discontinuous range 

of project sequences. 
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4.6.5 alignment, clustalw 

This function uses the Clustal programs to perform the actual alignment. 
The ClustalW program is fully integrated into SEQtools and it is not 
possible to change the default parameters used to for the alignment. 

ClustalX (described in the following section of the manual) is a stand-
alone Windows program with its own user interface including a large 

number of options influencing the alignment process. The File menu of the 
SEQtools alignment form allows you to choose which of the two programs 

you wish to use.  
 

The SEQtools interface to fully integrated ClustalW program allows you to 

specify the output format and - on the second tab of the alignment form 
to alter the sequence names used by ClustalW in the finished alignment. 

The Select command button opens the project sequence list for selection 
of sequences to align: 

 

 

Clicking the Accept command button, populates the sequence list with the 
selected sequences. You can edit the list only by removing items (select 

and click Remove). If you wish to post-process the alignment, choose the 
GCG output format to enable the menu options on the alignment result 

form to the GeneDoc, TreeView and T-Coffee programs provided GeneDoc 

and TreeView are properly installed on your pc and that SEQtools has 
been informed by adding the two programs to the Launch menu. Clicking 

Action starts the alignment process displaying the progress in the info line 
of the form. 
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The tab for selecting a different source for the names for the sequences to 

be aligned. Shift-Right clicking the sequence list opens a small text editor 
to allow you to edit individual sequence names one at a time.  
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The output form of the Clustal alignment. Note that the menu line 

contains direct access to the programs GeneDoc, TreeView and T-Coffee. 
 

 

 
4.6.5.1 T-Coffee - is a very powerful routine for optimizing the initial 

clustal alignment. Users with sufficient RAM (in most cases t-coffee 
requires 0.5 - 1.0 Gb of RAM if you want to optimize alignments 

consisting of more that a few sequences). SQTtools warns you in the 
message displayed below also informing you of the amount of free RAM 

on you pc. Optimization will terminate if the pc runs out of ram while 
optimizing the alignment. 

 

 

Successful optimization with T-Coffee is indicated in the top line of the 

alignment as shown below. 
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4.6.5.2 GeneDoc - is an extremely powerful alignment editor providing 
facilities for very advanced editing and annotation of the alignment. 
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4.6.5.3 TreeView - this small program enables you to build a 

phylogenetic tree of the aligned sequences at a single click.  
 

 

4.6.6 alignment, clustalx 

The ClustalX program is powered by the same routine as ClustalW but has 
its own user interface allowing you to specify a large number of 
parameters for the alignment. The resulting file - when saved in GCG 

format - is auto-imported into SEQtools when you close ClustalX. 
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Alignment created by ClustalX and re-imported into SEQtools after closing 

ClustalX. 
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4.6.7 sequence merge editor 

This function is designed to assist you in building and editing merges of 
overlapping nucleotide sequences. Although this merge function appears 
rather primitive, extended use of the function for finishing small 

sequencing projects has demonstrated that it works quite effectively in 
creating an error-free consensus sequence from the sub sequences. 

 
Click Select to display the project sequence list for selecting the 

sequences to me merged - when done click Accept. Set the Preferences 
(main menu) and click Merge. It is not possible to change preferences 

after the sequences are merged so be sure to do it correctly before you 

click Merge. When merging is complete a small window pops up informing 
you about included and excluded sequences, the page number and the 

bases on the page. 

The merged sequences are contained on separate, fixed pages. You 
navigate between the pages of the merge by the <Page UP> and <Page 

Down> keys. Press the >CTRL + G> keys to display the goto field and the 
<ENTER> key to jump to the specified base - or to close the goto field. 

The bottom panel on the merge editor informs you about sequence name 
of the clicked sequence, total length and number of discrepancies (in red) 

on the displayed page. 

When editing is completed, click the Verify command button to rebuild the 
merge and the consus sequence displayed above the merge. This enables 

the Save and Print options under the File menu. You can append the 
consensus sequence to the current project by clicking Build/Store 

Consensus and Build/Update Project to update the project sequences with 

the changes made during editing the merge.  
 

Remember that all information is SEQtools is stored in RAM on your pc 
until the project is saved. To undo the changes made while editing the 

merge, simply close the project without saving it. 
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The merge editor info form. 
 

 

Setting the preferences for the merge editor must be set before merging 

the selected sequences. 
 

 

4.6.8 merge sequences, emboss 

A small feature which was used to automatically merge forward and 
reverse sequence for EST inserts on the same plasmid.  

 
The function requires that clones are named as indicated on the merge 

form: forward and reverse sequence must have identical leftmost 
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characters (first six characters of the sequence name) and a closing -F for 

forward and -R for reverse sequences of the same insert. The merged 
sequence will receive -M as the last two characters of their sequence 

name. 
 

The merged sequences are appended to the current project. 
 

 

The SEQtools function uses the emboss Merger routine to perform the 
actual merging with the argument options shown on the Merge Criteria 

tab of the form (below). 
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The Advanced Options tab enables you to tell SEQtools to complement 
sequences to be merged, to close (i.e., remove from current project) the 

-F and -R sequences successful merged. 
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4.6.9 clustering 

This function allows you to perform nucleotide sequence clustering with 
three different methods: 
 

- based on score values,  
- by the NCBI blast clust program 

- by pair wise sequence alignments. 
 

4.6.9.1 Blast score values - The function automatically creates a local 
database with formatdb (NCBI) and performs the blastn search against 

this to generate temporary blastn score values used for clustering. The 

self-score value (the score value obtained when the sequence is 
compared to itself) is extracted for all sequences contained in the project. 

Then, the score value for each local blastn match is normalized by division 
with the self-score value. Finally, the normalized score values are 

compared to the selected score-cutoff limit and matches less than the 
cutoff are rejected. 

 

 
 
 

4.6.9.2 Blastclust program - Blastclust automatically and 
systematically clusters protein or DNA sequences based on pairwise 

matches found using the blast algorithm in case of proteins or mega blast 
algorithm for DNA. In the latter case a single Mega BLAST search is 

performed for all the sequences combined against a database created 
from the same sequences. Blastclust finds pairs of sequences that have 

statistically significant matches and clusters them using single-linkage 

clustering. 
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Blastclust uses the default values for the blast and mega blast 
parameters. For protein sequences these are: matrix Blossum62; gap 

opening cost 11; gap extension cost 1; no low-complexity filtering. For 
DNA sequences: match reward 1, mismatch penalty -3, non-affine 

gapping costs, wordsize 28. In both cases e-value threshold is set to 1e-
6. (from the NCBI blastclust documentation). 

 

 
 
 

4.6.9.3 Blastn alignments - This function first creates a local database 
including all sequences in the project with formatdb, performs a blastn 

search for all sequences and collects the best alignment for each 
sequence. The alignments are parsed to identify sequence pairs sharing a 

minimum length identical region with the specified number of 
mismatches. The list is used to generate the reports described below. 

 

The three functions will in most cases yield the same overall clustering of 
sequences. There are, however, situations where the blastn alignment-

based method yields a more reliable clustering: Long sequences with 
small overlaps from the same open reading frame may be lost when 

blastn clustering is used but will, if they share just a short identical region 
be linked by the alignment method. On the other hand, sequences from 

different ORFs sharing a short identical region may erroneously be linked 
with the identical region method but not when local blastn score data are 

used. 
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4.6.9.4 Output - A cluster tree listing all clusters resulting from the 

clustering process. Clicking a node in the tree retrieves a list of 
description lines for the cluster. As for the project sequence list, selecting 

a line and holding down the right mouse button in the cluster member list 
displays the blast descriptions for the selected sequence. 

 

 

The cluster group form. Note that there are direct access (when two or 
more members of the cluster group are highlighted) to Aligning and 

Merging (in the merge editor described above)the members of the cluster 

group on the menu. 
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4.6.9.5 Clustering report - The clustering report simply lists the 

clusters generated by either method. A summary section is included in 
front of the list giving overall values for redundancy, number of unique 

clones in the project etc. 
 

4.6.9.6 Deduced clone report - The deduced clone report processes the 
sequence report by removing all but one of sequences sharing the 

specified number of file name characters. This option allows you to 
remove multiple sequences originating from the same clone provided that 

the sequences are named consistently: 
 

Example: 

original cluster: 

 CLONE001-2.SEQ 

 CLONE001-4.SEQ 
 CLONE001-1.SEQ 

 CLONE002-2.SEQ 
 CLONE002-3.SEQ 

 CLONE003-7.SEQ 
 CLONE003-8.SEQ 

 CLONE005-4.SEQ 

 CLONE005-12.SEQ 
 

processed cluster (significant characters = 9): 

 CLONE001-2.SEQ 

 CLONE002-2.SEQ 

 CLONE003-7.SEQ 
 CLONE005-4.SEQ 

 

The two optional reports, File/Sequence Cluster Report and the 
File/Deduced Clone Report are displayed on a separate Result form. 
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4.7 ANALYZE MENU 

1. 4.7.1  about analyze (general comments) 

2. 4.7.2  protein properties 
3. 4.7.3  base composition 

4. 4.7.4  codon usage 

4.7.1 about analyze 

A few utilities for sequence analysis are collected under this menu. 
 

 

Note that the content of the Analyze menu is dependent upon project 
type (nucleotide or protein) and on the sequence type currently displayed. 

 

 

4.7.2 protein properties 

This utility analyses the currently displayed protein sequence in a protein 
project or a translated nucleotide sequence displayed in the main 

SEQtools editor window. A number of protein properties are included in 
the form. 
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The Hydrophopacity menu item includes three different algorithms for 

calculating the hydropathy plot. The dropdown list allows you to select the 
width of the sliding window for smoothing of the plot. 
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4.7.3 base composition 

When opened this small form lists the base composition of the currently 
displayed nucleotide sequence. The option is disabled in protein projects. 
 

 

4.7.4 codon usage 

An elaborate function for analyzing and using codon usage tables in 
SEQtools nucleotide and protein projects. In the latter case the menu 

item is disabled, but the form is opened when back-translating protein 
sequences into degenerate primers. 

In addition to displaying the codon usage table for the displayed protein 

the function also allows you to build a codon usage table for a particular 
organism. 

 

The facility is described in the following screenshots. 
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An open reading frame is identified (see the Translate menu) and 

highlighted in the sequence displayed below. The second step is to launch 
the codon usage form. 

 

 

When the codon usage form opens the highlighted sequence is 

automatically processed and displayed. 
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Under the Codon Usage Current tab the codon usage for the selected 

protein sequence displayed. The popup menu is opened by right-clicking 

the data field and enables you to display the data in a number of formats. 

Note that the currently selected Main codon usage table for the project is 
"MUS_MUSCULUS.COD" (displayed in the blue title bar of the form). If 

you wish to add the information for the current protein simply click Build 
to add (or subtract) the information to the project default table.. 
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If you want to create a new empty table click File/New Codon Usage 

Table, click File/Open Codon Usage Table to open an existing codon usage 

table (at the same time making it the default for the project) or add to 
the currently selected (default) table. 

 
SEQtools uses its own format (*.cut) which in addition to codan usage 

data also keeps track of the sequences which provided the information; 
click Info/Codon Table Header to display this information. 
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The File menu includes options for Printing, Saving and Exporting codon 

usage files. 
 

 

As an aid in designing sequencing/PCR primers, it is finally possible to 
display only the preferred/avoided codons for the table displayed under 

the Main tab (i.e., for the entire codon usage table). The data are from 
the Mus musculus codon usage table. 
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Avoided codons in the Main codon usage table. The data are from the Mus 
musculus codon usage table. 
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4.8 HEADER MENU 

1. 4.8.1  about sequence headers (general comments) 

2. 4.8.2  sequence header 
3. 4.8.3  multi-database header data 

4. 4.8.4  compose displayed header (virtual blast search) 
1. 4.8.4.1    blast searches 

2. 4.8.4.2    blast and user data 
3. 4.8.4.3    project and imported data 

4. 4.8.4.4    special data 
5. 4.8.4.5    replace database name 

6. 4.8.4.6    search header 

7. 4.8.4.7    create new project 
5. 4.8.5  user comments 

4.8.1 about sequence headers 

The main Sequence Header form is used to display selected information 
for each project sequence as selected in the Compose Displayed Header 

form described in section 4.8.4. In addition the header menu contains 
options to display the results of a local multi-database search and to add 

user comments to project sequences. 
 

 

4.8.2 sequence header 

The Header form is intimately linked to the Compose Displayed Header 
facility to compose the content of the currently displayed header. 

Individual sequences are often associated with a large amount of 
information primarily derived from blast searching but also from other 

analyses carried out with SEQtools functions. It is inconvenient to display 
all information in the header. A more rational approach is to select only 

the information of interest in a certain context. 
 

Navigation, command buttons and icons on the right hand panel are more 
(or less) self explanatory and will not be described here: Try and learn... 

The only facility which perhaps should be mentioned is the Copy 
command button which copies the current sequence to the clipboard 

(listing the first and last parts of the sequence in the field to the left of 
the command button. 

 

Below is illustrated and explained one of the features of the header form: 
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For local database searches if is sometimes convenient to be able to 

retrieve the database sequences for a closer inspection. By highlighting a 
description block in the header (after including the local search in the 

displayed header) and clicking the fishing rod icon causes SEQtools to 
retrieve the listed sequences from the database and offer several options 

for the further action (see the Retrieve menu below). 
 

 

Retrieving sequences from the local database is not possible unless the 
database is constructed with the NCBI program FormatDB -o option set to 

true. 
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It is also not possible to retrieve database sequences from Genbank with 

this method. SEQtools does not at the moment include a function to batch 
retrieve blast matches from Entrez for a single blast description header 

section. This is, however, a fairly easy routine to add to SEQtools. Should 
anyone need this facility, send me a word. 
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4.8.3 multi-database header data 

This function was originally designed to compare viral genomes by a 

French research group. The function is similar to the Local single database 
search function but accepts multiple databases and has different options 

for analyzing / displaying the result of the search. The function is 
described in detail on Local single database search under the Search 

menu. 
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4.8.4 compose displayed header 

This form is the key to controlling display of information stored in 

sequence headers. Extensively annotated sequences contain a large 
amount of information in their headers and without a facility to filter this 

information before displaying it would render the displayed headers rather 
confusing and difficult to use in a rational way. The Compose Displayed 

Header form helps you temporally hide irrelevant information. You will see 
the icon for this form in several places in SEQtools. 

 
The compose form includes three tabs containing checkboxes for all 

possible header sections, sections without information (for all project 
sequences) being disabled. To compose the displayed header simply put 

checkmarks in the sections you wish to include. When done click Build 

Virtual Search to construct the displayed header consisting of the checked 
items. 

 
Note that a header section becomes enabled if just a single section in the 

project contains information in a particular section. Use the Skip Empty 
Headers to skip sequences lacking information when navigating among 

headers. 
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4.8.4.1 Blast searches - Select blast searches to be included in the 

virtual blast search. Note that the first blastn search is on a local database 
(PROJECT98). The selection of information from checked blast searches in 

the list is prioritized: If the first blast search fails to yield a results (i.e., a 
best match line) the function tries the second selected blast search and so 

on. The identity of the blast search used for a given sequence is indicated 
in the project sequence list.  

 
Change the list order by highlighting a line and click Up or Down to shift 

its position - and thereby its priority. 
 

 
 
 

4.8.4.2 Blast and User Data - Header sections covering Blast results 
and various User comments. 
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4.8.4.3 Project and Imported data - Various project related sections 

and sections holding different types of Imported information. 
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4.8.4.4 Special data - A collection of difficult-to-classify types of 

information. 
 

 
 

4.8.4.5 Replace database name - List of available local and global blast 
searches. The File menu includes - in addition to other options - also a 

delete option. To avoid unintentional removal of header information the 
following procedure should be followed: (1) Rebuild the list of blast 

searches, (2) select one blast search (i.e., a single line) and (3) finally put 

a checkmark in one (and only one) header section. Then click the Delete 
menu item under the File menu. This implies that you have to delete each 

section of the header at a time to remove a particular blast search from 
the header. 

 
Below is described how to alter the name of the databases in the list. This 

option should also be used with caution to avoid messing up the 
information stored in headers.  

 
The only situation where this facility is required is really in cases when 

you import sequences from a different SEQtools project searched with a 
local database with the same content but a different name. In this 

situation the two searches on the same database will be listed as two 
different searches because the database names are different. Changing 

one of the database names to exactly the same as that of the other 

search will merge the two blast searches into a single search. 
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Warning before accepting changes to a database name. 
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4.8.4.6 Search header - The Search Header function enables you to 

sear the displayed header for a query text string. Matches are highlighted 
(in red) when clicking an item in the match list.entire header. If you want 

to search the complete information stored in sequence headers build a 
displayed header containing all information stored in the header by 

clicking the Show Complete Header command button on the Compose 
Header form. 

 

 
 
4.8.4.7 Create new project - A small facility to allow you to collect 

sequences for a new project while inspecting sequence headers the 
project. Simply click Add to include the current sequence + header in a 

new project. When done choose from the File menu of the Compose 
Project form. Options are: (1) Remove from project, (2) Save multi-

sequence file, (3) Open new instance of SEQtools with the selected 

sequences and (4) Print list. 
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4.8.5 user comments 

A Form to enter user comments for the current sequence or to the 
specified range of project sequences. The user information is stored in 
separate header sections and can be selected individually. See the Project 

menu for a detailed description of how to use the Edited Genbank 
description line feature. 
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4.9 PROJECT MENU 

1. 4.9.1  about the project menu (general comments) 

2. 4.9.2  edit project composition 
3. 4.9.3  merge project sequences (and close) 

4. 4.9.4  project file lists 
5. 4.9.5  project statistics 

6. 4.9.6  find identical sequences in project 
7. 4.9.7  sequence list form 

1. 4.9.7.1    file menu (list form) 
2. 4.9.7.2    save tab-delimited list 

3. 4.9.7.3    export to excel spreadsheet 

4. 4.9.7.4    view menu (list form) 
5. 4.9.7.5    format menu (list form) 

6. 4.9.7.6    options menu (list form) 
7. 4.9.7.7    align menu (list form) 

8. 4.9.7.8    entrez menu (list form) 
9. 4.9.7.9    find menu (list form) 

10. 4.9.7.10   refresh menu (list form) 
11. 4.9.7.11   user comments (edited description lines) 

4.9.1 about the project menu 

Under this menu are collected functions/facilities designed to edit project 
composition and to display a list of sequences included in the project. The 

latter form provide extensive options for customizing the way project 
sequences are listed. In addition to a simple list containing "raw" 

sequence data (length, orientation, checksum etc.) it is possible to use 
information contained in the sequence header to list the project 

sequences. The sequence list form is explained in detail below. 
 

 

 
4.9.2 edit project composition 

This form contains three functions for finding and removing sequences 
from the project: Bad quality sequences with many ambiguous positions 

(N's), sequences similar to those contained in a specified local database 
(for example containing a selections of vector sequences) and sequences 

shorter than a specified minimum length. 
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Parameters for finding low quality sequences.  
 

 

Parameters for finding similar sequences. 
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Parameters for finding short sequences. 

 

 

Result list. The Match column indicates whether or not the specified 

criteria were met for all project sequences. Click Remove "False" to close 

sequences not meeting the criteria or Remove "True" to close sequences 
meeting the criteria. 
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4.9.3 merge project sequences 

This function also appears under the Compose menu. It is included here 
because it allows you to replace merge able forward and reverse 
sequence pairs originating from the same plasmid / insert by their 

merged sequence - closing the forward and reverse sequences after 
successfully creating the merged sequence. Consult the Compose menu 

for more details. 
 

 

4.9.4 project file lists 

This menu includes various options for printing and saving project 
sequence file lists. As described in detail under the File menu the plp and 
psp files can be used to open the project from a list of full file paths. The 

psp file editor allows you to combine two psp files in various ways. 
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The psp file editor and its options. 

 

 

 

4.9.5 project statistics 

This function calculates and lists various quantitative information for the 
project sequences. 

 

 

4.9.6 find identical sequences in project 

A quick way to find and close duplicate (identical or similar) sequences in 
the project. 
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4.9.7 sequence list 

The sequence list form is rather complex with a very large number of 
options for displaying the project sequences based on available 
information in sequence headers. Many of the options require that you 

have performed one or more blast search and retrieved relevant 
supplementary information from Entrez (e.g. full genbank records for the 

best matches of blast searches). The list options (other than listing plain 
sequence data) also require that you include the information you wish to 

use in the sequence list in the virtual header . 
 

The facilities are explained in some detail below to present the 

possibilities for extracting and displaying information stored in sequence 
headers. The row of icons on the right hand panel of the form provides 

direct access to most of the functions and options also included in the 
menus. 

This screenshot below shows the project sequences listed according to the 

search result of a blastx search on genbank section: all non-redundant 
genbank cdc selected as the virtual blast search in the Header Compose 

form. All information in the table is derived from the blast description and 
alignment sections of the sequence header. Other options for data display 

are included under the View menu the available options reflecting 

information included in the virtual blast search. 
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Example: If you include Genbank records, best match in the virtual blast 

search an option to use this information for displaying project sequences 
in included under the View menu, whereas this option is not available if 

Genbank records are omitted from the virtual blast search. 
 

 
4.9.7.1 File menu - The File menu includes various options for exporting 

the project sequence list. For all functions the exported list is the 
currently displayed project sequence list. The choices for each export 

option varies, but are self explanatory. Briefly you can export highlighted 
lines or lines not highlighted, include information in individual columns, 

etc. 
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4.8.7.2 Tab-delimited sequence list for saving the project 

sequence list. - This facility allows you to compose and save a tab-
delimited project sequence list including selected sequences from the 

project sequence list. 
 

 

Project sequence list consisting of the checked items. 
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4.9.7.3 Export to Excel spreadsheet - Options form for exporting the 

project sequence list to an Excel spreadsheet. 
 

 
 

 
4.9.7.4 View menu - The content of the View menu reflects the header 

information available for the project sequences. Enabled menu items 
causes an update of the project sequence list reflecting the source of 

information.  

 

 

4.9.7.5 Format menu - The Format menu items provide access to 
several functions/settings affecting the line format: 

• Build Virtual Blast search enables you to change the content of the 

virtual blast search. 
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• Edit FastA Definition Lines is a editor for composing/editing the 

content of definition lines in fasta formatted sequences. 

• Format Description Lines, described in detail under the Preferences 

menu, is an advanced filter for customizing / filtering description 
lines from blast search results. 

• Line Formatting Off turns off line filtering. 

• Edit Description Lines opens the User Comments form to enable you 

to add various comments and to create your own Genbank 
descriptions (only enabled when the project sequence list displays 

Genbank records). See below for details. 

 

4.9.7.6 Options menu - A quick way to alter the width of the description 
column of the list. 

 

 

4.9.7.7 Align menu - The project sequence list provides direct access to 
alignment by Clustal. Simply select the sequences you want to align and 

click ClustalW (SEQtools user interface) or ClustalX (with its own user 

interface and many more options): 
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4.9.7.8 Entrez menu - When the Launch Entrez With Accession Number 
On Shift-Click is enabled you can highlight a line in the project sequence 

list containing an accession number (i.e., list display by blast search 
results or by Genbank records) and shift-click to launch retrieval of the 

highlighted sequence in a web browser from Entrez. web browser with the 
se: 

 

 

 

 

4.9.7.9 Find menu - The search option allows you to search either 
description lines  

only or all other fields (and not description lines). Hits are highlighted in 
the project sequence list. 
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4.9.7.10 Refresh menu - These options are used to rebuild/update the 
project sequence list. In most cases the list is updated automatically but 

some changes may require manual action. It is also possible to invert 
selections and to remove highlights (not the sequences). 

 

 

4.9.7.11 User edited Genbank information - Sometimes you may 

want to create an alternative description line to a given gene, add a 
comment to the gene (or to all sequences in the project), to add key 

words to facilitate searching headers or grouping sequences or to add 
your initials (for example) in front of the descriptions. The User 

Comments form is intended for these purposes.  
 

The highlighted menu item in the form below allows you to use the 
original Genbank description lines or those created by yourself. The 

highlighted lines in the sequence list have been changed to illustrate this 
facility. Note that this option is only available for Genbank descriptions. 
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4.10 LAUNCH MENU 

1. 4.10.1  about the launch menu 

2. 4.10.2  populating the launch menu 
3. 4.10.3  supported external programs 

1. 4.10.3.1  GeneDoc - alignment editor 
2. 4.10.3.2  TreeView - draws phylogenetic trees 

4. 4.10.4  auto-installed external programs (Clustal, Chromas, t-
coffee) 

4.10.1 about the launch menu 

SEQtools depends on a number of external programs. The important 
resources provided by NCBI for example are all included in the SEQtools 

setup file and are available in the auxuliary8.exe update file. Other 
programs come with their own setup file and must be installed as 

individual programs for SEQtools to use them (GeneDoc, TreeView). It is 
therefore necessary to inform SEQtools where these programs are 

located. This is done as described in the populating the launch menu 

below. It is possible to access the programs directly from the Launch 
menu. 

 
Other external programs (Chromas, T-Coffee) have no specific SEQtools 

interface but are used - and installed - by the setup file. 
 

Finally you may wish to have easy access to certain other programs. This 
can be achieved by including the path to such programs on the Launch 

menu. 
 

 

4.10.2 populating the launch menu 

Adding new items to the Launch menu is described in detail on the 
preferences menu. Briefly, select the line where you want the program to 

appear, browse to the location of the exe file of the program and press 
<Enter> when you have found it. The application title is automatically 

inserted in the editable right text field. Remember this is only possible 
after the application is properly installed on your pc. A maximum of five 

external applications can be included. 
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4.10.3 supported external programs 

Two separately installed external programs (GeneDoc, TreeView) are 
interfaced to SEQtools and are accessed from the Clustal results form. A 

third external program, T-Coffee, is a dos program, installed by the 
SEQtools setup file and runs in the background without a user interface. 

All three programs are used to post process sequence alignments created 

by ClustalW. To use these programs, first perform a sequence alignment 

with ClustalW. When the output format is set to GCG - and only then - the 
three programs can be accessed from the main menu of the Clustal 

results form. 
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The ClustalW results form with the three external programs on the menu 

line. Note that the results menu will only display these menu items if the 
ClustalW output is set to GCG before the alignment process is launched 

from the alignment form above. 
 

 

4.10.3.1 GeneDoc - alignment editor 

GeneDoc is a very powerful editor with numerous options for editing and 

annotating sequence alignments. It will take some experimentation to get 
familiar with this excellent program. The program is written by Karl 

Nicholas and is freeware. Download the program from Karl Nicholas' 
homepage. 

The GeneDoc editor in action: 
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4.10.3.2 TreeView - draws phylogenetic trees 

TreeView is written by Roderic D. M. Page and is freeware. You will find a 
manual to TreeView at the Glasgow University homepage. The program 
can be downloaded at the same place. 

Phylogenetic tree created by TreeView for the set of sequences shown in 

the GeneDoc editor above: 

 

 

4.10.4 auto-installed external programs 

ClustalW, ClustalX, Chromas as well as t-coffee are all included in the 
SEQtools setup file and are installed automatically. Read more about 

these programs on their respective homepages. 
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4.11 TOOLS MENU 

1. 4.11.1  about tools 

2. 4.11.2  translators 
1. 4.11.2.1    IUB symbol converter 

2. 4.11.2.2    codon calculator 
3. 4.11.3  conversion functions 

1. 4.11.3.1    convert project to data file 
2. 4.11.3.2    accession number to GI converter 

3. 4.11.3.3    restriction enzyme data file converter 
4. 4.11.4  multi-sequence functions 

1. 4.11.4.1    create local databases 

2. 4.11.4.2    multi-sequence tools 
3. 4.11.4.3    build project from genbank records 

4. 4.11.4.4    import annotation 
5. 4.11.5  file tools 

1. 4.11.5.1    search and view text files 
2. 4.11.5.2    lifetrace data file viewer 

3. 4.11.5.3    primer order file viewer 
4. 4.11.5.4    file and folder tools 

6. 4.11.6  editors 
1. 4.11.6.1    sequence merge editor 

2. 4.11.6.2    text editor 
3. 4.11.6.3    search data file editor 

4. 4.11.6.4    fasta definition line editor 
7. 4.11.7  calculators 

1. 4.11.7.1    dna concentration calculator 

2. 4.11.7.2    math calculator 
8. 4.11.8  create files 

1. 4.11.8.1    batch translation 
2. 4.11.8.2    est submission to genbank 

3. 4.11.8.3    sequence list, tab-delimited 
4. 4.11.8.4    multi-record file parser 

4.11.1 about tools 

The Tools menu groups a series of functions for special purposes.  Some 
of the tools functions are also included under other SEQtools menus but 

are repeated here to facilitate accessing/locating them functions. Look 
through the list below to get acquainted with the options available by 

these tools. 
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4.11.2 translators 

Simple translators included to the benefit of users of SEQtools (including 
myself) who still have to look in a test book to find the amino acid 

corresponding to a particular codon and who have problems remembering 

the IUB symbols (published by Commission on Biochemical Nomenclature) 
for degenerate positions in sequences. 

 

 
 

 
4.11.2.1 IUB symbol converter - Symbol Translator for conversion of 

degenerate bases of a codon to and from the standard IUB symbols 

(Nomenclature Committee, 1985, Eur. J. Biochem. 150, 1-5). These 
symbols are used by the EMBL, Genbank and PIR data libraries and are 

recognized by the programs of the GCG package. 

Translate from IUB symbol to Normal syntax. 
 

 

Translate from Normal syntax to IUB symbol. 
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4.11.2.2 Codon calculator - The Codon Calculator is used to translate 

codons into amino acids or amino acids into their respective codons. The 
list of valid codons for a particular amino acid also includes the 

corresponding degenerate codon using the IUB symbol table.  
 

The tab key or a click toggles between codon and amino acid input. N's 
are allowed when entering codons. The function of the Codon Calculator is 

illustrated in the screenshots below. 
 

 

 

 

4.11.3 conversion functions 

Three functions for conversion purposes. The first converts an entire 
project  into a search data file which can be used in the same way as 

restriction enzyme data flies. In most cases this would be primer 
sequences for PCR or sequencing purposes. The remaining two converters 

reformats a restriction enzyme data file downloaded from ReBase in GCG 
format and converts gene accession numbers (AC) to GI numbers. 
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4.11.3.1 Convert project to data file - Using SEQtools as a primer 

"database" including the primer sequences in a normal nucleotide project 
offers several advantages: The primer sequences can be 

annotated/verified by Genbank searching relevant databases. This 
annotation is stored in the sequence header of the primer sequence. You 

can then use sequence listing and searching facilities to identify for 
example primers for a particular organism, gene etc. 

 
With this function all sequences of the current project can be converted 

into a SEQtools search data file. This is especially useful to verify the 
sequence and location of primer sequences (sequencing and PCR primers) 

derived from a known sequence. 
 

The *.sdf file can be used to search project sequence in exactly the same 
way as normal restriction enzyme search data files. Displaying the 

primers in a map or as a list, just as described for restriction sites greatly 

facilitates the verification of the sequence and location of primers. 
 

Note that the Convert Project function uses the exact same sequence as 
included in the project. This implies that restriction sites or linkers which 

may have been added to the primer sequence are included in the search 
data file. 

 
4.11.3.2 Accession to GI number converter - Submits a list of 

genbank accession numbers (AC) to entrez to get the corresponding GI 
numbers. 
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4.11.3.3 Restriction enzyme data file converter - A small program 

used to convert the restriction enzyme data files in GCG format to 
SEQtools format. Further editing of the converted data file can be carried 

out with the data file editor (see below). 
 

To convert the data file simply download the restriction enzyme data file 
in GCG format from Rebase and follow the instructions under the File 

menu of the Converter form. Note that in addition to enzyme data files, 
ReBase contains very useful search function which allows you to search 

their data base, either with the name of an enzyme or with a recognition 
pattern. 

 

 

4.11.4 multi-sequence functions 

The first item on the, Create Local Databases menu is described is some 
detail. It is my experience from many user comments that this essential 

feature of SEQtools is sometimes difficult to get to work. The next menu 
item, on the other hand, contains a collection of old routines whish are 

seldom used. The current descriptions are copied from the previous 
manual and not check very carefully here. New Project From Genbank 

Records and Import Annotation From MS-File are also included under 
Retrieve menu and are only described very briefly here. 

 

 
 
4.11.4.1 Create local databases - This form contains several functions 

and utilities for creating local database files. Building a local database 
involves two steps: (1) Create a FastA source file for formatdb (routine 

provided by NCBI to build blast searchable databases). (2) Run formatdb 
with the source file just created. 
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This collection of programs allows you to (1) combine all sequences 
located in a particular directory, (2) all sequences included in a SEQtools 

project or (3) sequences you type yourself into a source file for formatdb. 
The form also includes a simple tool for managing existing SEQtools 

databases which is handy if you want to remove a databases from the list. 
 

(1) Create source files from files in a directory - to create a FastA 
source file it is necessary to collect all the sequences you wish to include 

in the source file in the same directory. Remember ALL files in the 
specified directory are included in the database - also text and program 

files not containing sequences - so please check the content of the 
directory carefully before you start building the database. 

 
The File and Folder Tools utility described below is useful in getting a list 

of the files to be included in the database. If the sequences are annotated 

by SEQtools it is also necessary to indicate which header section you want 
to use for annotating the source file and thus also the database. 

 
(2) Build source file from sequences in a SEQtools project - This 

function works in the same way as described above, except that the FastA 
source file is built from the sequences and their headers contained in the 

current SEQtools project. 
 

To create a local database simply select the source file you wish to 
convert, choose a name for the database and select whether the source 

file contains nucleotide or protein sequences. Check the -o option 
enabling later retrieval of sequences from the database. Then click the 

Action command button. 
 

The files comprising the local database are created in the DT8_TEMP/DB/ 

folder in the Windows/Winnt folder - and must remain there if you wish to 
search it. A copy of the database is stored in ...\SEQtools\_databases. 

 
In case you want to create a protein data base from a project containing 

DNA sequences use the Create Protein Files under the Translate menu to 
translate the nucleotide sequences into protein before building the source 

file and the final data base. 
 

(3)User strings databases - In case you wish to create a database 
from a smaller number of sequence motifs, you can use this function to 

enter nucleotide or protein strings, give them a name each and finally 
convert the strings into a searchable database. 

The sequences included in the database will contain only a single 
annotation line. If the input sequences are in Genbank, FastA or GCG 

format, the annotation is automatically retrieved from the original files. 
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For Genbank files the DESCRIPTION line is used, for FastA, the standard, 

single line annotation is included and for GCG, the line immediately before 
the .. divider. 

 
For SEQtools files, the header sections listed on the form select which 

header section is used for annotation. The default is sequence name, 
length, check sum and file date. Obviously only header sections actually 

containing information can be used to annotate the database. 
 

After a while, the number of local databases may become too large 
making it difficult to find the one you wish to use. With this facility you 

can remove databases from the list. There is no undo option so the 
operation is final. It is, however, possible to rescue a deleted database by 

locating the database files generated by formatdb in the 
...\SEQtools\_databases folder and moving them to the general DOS 

folder, specified above. 

 
The most important tabs of the Local Database Tools form are shown 

below: 

The Build FastaA Source File tab. 
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The Convert Project to FastA Source File tab. 

 

 

 

The Create Database from FastA Source tab. 
 

 
 
 

4.11.4.2 Multi-sequence tools - This function allows you to modify or 
create multi-sequence files. Database files in FlatFile or FastA format 

consist of text documents containing multiple database records in plain 
ASCII text format and can be downloaded from several web sites. The 

description below is the unmodified from the previous SEQtools web 
manual and may not be correct in all aspects.  
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Format multi-sequence files - This function checks the EOL (end of line) 

codes of multi-sequence files to see if LF is used alone. If this is the case, 
all LF codes are replaced by CRLF codes and the formatted file is saved 

with the same name but with the extension *.fgf (Formatted Genbank 
File). In cases where the correct CR code is used, a copy of the file is 

saved with the *.fgf extension. 
 

The Process Annotation functions reduce the annotation of each of the 
sequences in a Genbank flatfile or a collection of Genbank files located in 

the specified folder leaving only the DESCRIPTION line and the 
ACCESSION line intact. The ORIGIN divider and the // record separator 

are also maintained in the trimmed file. 
 

Sequences contained in a multi-sequence file - If a value is entered in the 
reject field, sequences longer than the specified length are  excluded from 

the trimmed file. In most cases such long sequences comprise multi-gene 

sequences which may be undesirable. 
 

Separate sequence files in a folder - The input file must be a file with the 
*.fgf or *.ngf extension, i.e. a user generated file or a Genbank file where 

the EOL codes have been checked and replaced if incorrect. The trimmed 
file is saved with the same name as the input file but with the extension 

*.tgf (Trimmed Genbank File). 
 

Derived genbank - This function allows you to extract a subgroup of 
sequences from a formatted Genbank file, e.g. EST sequences derived 

from a specific organism from the complete EST data base flat file. The 
Genbank file must be in standard format where the sequence portion of 

each record is delimited by ORIGIN and //. The annotation part must 
include DEFINITION , ACCESSION, ORGANISM and REFERENCE sections. 

This function does not work with multi-sequence files in FastA format or 

with trimmed Genbank files. 
 

Criteria - The criteria for selecting files for the derived Genbank file are 
entered using the logical operators AND and NOT as exemplified below: 

• AND Homo (retains all files containing the word Homo/HOMO/hoMo 

in the annotation 
• NOT Yeast NOT Saccharomy NOT cerevisiae (selects all sequences 

except yeast sequences) 
• AND Plant (retains all plant sequences) 

• AND Fungi (retains fungal sequences) 

Note that a maximum of five AND and five NOT words are allowed in the 

criteria string. If more than five words in each category are included, the 
excess words are disregarded in the selection. The logical operators and 

the keywords must be separated by spaces. The search is case 
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insensitive. 

 
The input file must be a file with the *.fgf or *.ngf extension, i.e. a user 

generated Genbank file or a Genbank file where the EOL codes have been 
checked and replaced if incorrect. The derived file is saved with the same 

name as the input file but with the extension *.dgf (Derived Genbank 
File). 

 
Obviously, this function is only relevant for Genbank files where the 

annotation has not been trimmed with the Remove annotation function. 
 

Create FastA flatfile - With this function it is possible to build a new flatfile 
formatted Genbank file from your own sequences. Before you attempt to 

build the file, make sure that all sequences to be included in the file are 
located in the same directory. The record format of the new Genbank file 

is almost the same as that of trimmed Genbank files and the extension of 

the new file is *.ngf (New Genbank File). 
 

The only sequence identifying information preserved is the file name 
which is included after DESCRIPTION, all other information contained in 

the header is lost. 
 

SEQtools accepts files both in Genbank, SEQtools and FastA format. In 
some cases, where entire data base files are present in the file header of 

files to be included into a Genbank flatfile, more than one 
header/sequence divider may appear in the file. This will result in 

incorrect separation of header/annotation and sequence. 
 

The solution to this problem is to load the files into SEQtools and save 
them again: SEQtools checks each file header for illegal dividers in the 

header before the file is saved. If multiple dividers are encountered in the 

header, they are converted to characters not recognized as dividers. 
 

This function can be used to create a multi-sequence file suited for sage 
tag extraction. In other words, you can avoid loading large numbers of 

files into a project for sage tag extraction if, instead, you first combine 
them into a multi-sequence file and then use the sage extraction function 

for Genbank files to generate the sage tag file. 
 

Break-up multi-sequence files - This function breaks-up a multi-sequence 
file in Genbank or FastA format and saves each sub-file in the same 

directory. The file names of the sub-sequences is composed of the 
accession number of the sub-sequence with the extension *.gbk for 

Genbank files and *.fsa for FastA files. 
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4.11.4.3 Build project from Genbank sequences - This rather 

complex function for creating a new SEQtools project from downloaded 
Genbank records is explained in detail under the Retrieve menu and will 

not be described here 
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4.11.4.4 Import annotation - The function for importing user created 

sequence annotation from a multi-sequence SEQtools file into the current 
project sequences is described under the Retrieve menu and will not be 

explained here. 
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4.11.5 file tools 

A group of functions for performing various tasks on plain text files and 
SEQtools generated data files. 

 

 
 
4.11.5.1 Search and view text files - Utility for viewing and searching 

all text files located in the specified directory without having to open the 
files manually. After selecting the directory and a search string, all files 

are opened - one by one - and the content automatically displayed. 
 

The search string can include three logical operators: AND, NOT, OR. 
Note that these operators will not work as parts of a search text string. 

The logical operators must be included by spaces to be recognized. 

 
Example: Protein AND Gene NOT Ribosome OR Chloroplast 

 
If a search string is not entered, all selected files will be displayed and 

included in the match-group. In the View menu you can select which files 
to display during the search: None, Matches, No matches or All. 

 
When the search is completed, double clicking a file name in the Match or 

the No-Match panel will retrieve and display the content of the file. The 
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displayed file can be printed from the Printer Options menu, or by 

pressing <CRLF+P>. 
 

The original files are not modified by this function. 

 
 

4.11.5.2 Lifetrace data file viewer - The basecaller LifeTrace is an 
advanced external basecaller  

for processing chromatograms generated by automated sequencers. The 
LifeTrace program and its setup is described in detail under the File menu. 

When debugging this program and its basecalling it is sometimes 
convenient to be able to view the data files (qscores, q and gap_qscores) 

in a slightly more organized way. 
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4.11.5.3 Primer order file viewer - If you are using SEQtools to handle 
your primer ordering, this viewer help you inspect primer order files. If 
you are using the encryption facility, the pincode used when saving the 

order file must be entered when viewing the file later. Read more about 
SEQtools and primers for sequencing and PCR on the separate page for 

Primer Design. 
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4.11.5.4 File and Folder tools - This small program enables you to 

carry out a number of operations on file and folder names. You can edit 
the file titles and extensions, change file dates, print and save file and 

folder lists etc. 
 

The program is very useful if - for example - you want to print out an 
index of the content of a CD or change all file dates to the current date. 
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4.11.6 editors 

This menu contain four editors for various purposes. The sequence merge 
editor is described under the Compare menu and will not be described 
further here. The Text Editor is an simple editor similar to Notepad. The 

data file editor is a utility for creating and editing different types of search 

data files. The FastA definition line editor is a more complex editor to 
enable you to customize definition lines for saving project files in FastA 

format. 
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4.11.6.1 Sequence merge editor - This function is designed to assist 

you in building and editing merges of overlapping nucleotide sequences. 
Although this merge function appears rather primitive, extended use of 

the function for finishing small sequencing projects has demonstrated that 
it works quite effectively in creating an error-free consensus sequence 

from the sub sequences. 
 

 

4.11.6.2 Text editor - A simple text editor for writing and saving plain 
text files. In addition to plain text, the text editor loads and saves files in 

rich text format. 
 

The text editor provides a number of properties you can use to apply 
formatting to any portion of text. To change the formatting of text, it 

must first be selected. Only selected text can be assigned character and 
paragraph formatting. Using these properties, you can make text bold or 

italic, change the color, and create superscripts and subscripts. 
 

4.11.6.3 Data file editor - The data file editor is used to make 
corrections and additions to existing search data files *.sdf or *.dat . In 

addition, the you can create new data files containing various collections 

of search strings such as selected groups of restriction enzyme 
recognition sites, DNA or protein motifs, primers, PCR primers etc. 

 
By default, the currently active data file is loaded into the editor when it is 

opened. To choose another data file for editing - or to create a new one 
use the File menu. Depending on the selection, the form changes slightly 

to accept DNA or protein search strings. Before a new entry can be 
appended to the data file, the string is tested to see if... 

• a search string name has been entered - and that the name is not 

already already in the data file. 
• a search string has been entered in the text field - and that the 

string is not already in the data file. 
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• cutting sites have been correctly entered in the Watson and Crick 

strands (DNA sequences only). 

To add a new item to the data file type the name and the search string in 
the respective fields and click Append. 

 
Cleavage sites - A star * is used to denote the position of a cleavage site 

in the Watson strand and a <space> in the Crick strand. of DNA 
sequences. 

 
Valid characters - The following characters A , C, G, T, N, * and <space> 

are allowed for restriction enzyme sequences. Deleting single characters 

can only be bone by the backspace key from the current position until the 
character is removed. All other editing keys are deactivated. 

 
For protein and DNA motifs other than restriction enzyme sequences, all 

keys are active and there are no l imitations - or verification - of the 
search string. See the detailed description of complex search patterns 

under the Search menu. 
 

Crick strand - The sequence of the crick strand is generated automatically 
and cannot be edited. 

 
Maximum length - The maximum length of a search string is 100 

characters. If cut sites are omitted, the string is classified as a user 
defined string. 

 

Validation - Validating the entry evokes the validation function without 
appending the search string. 

 
Sort Data File - This option retrieves the complete data file, sorts it 

alphabetically and saves the sorted file. Optimizing the data file in this 
way improves the performance of the search facility of SEQtools. A copy 

of the original file ($ replacing the last character of the file name) is saved 
before the sorted file. 

 
Convert To Complement - If this checkbox is checked, the currently 

displayed sequence are converted to its complementary strand (only for 
restriction enzyme sequences). 
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The Edit menu of the data file editor. 

 

 
 
4.11.6.4 FastA definition line editor - Utility for composing definition 

lines for sequences to be saved in FastA format. To use this function, it is 
necessary that all files to be saved in FastA format are loaded into a 

SEQtools project. As the function utilizes the header information of the 
sequences, it is also necessary that the sequences are properly 

annotated, i.e., contains the information to be included in the definition 
line in sequence headers. Modifiers are those included in the NCBI 

program SeqQuin. 
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Compose template - The procedure for composing a template for 

definition lines is straight forward: Select the items you wish to include in 
the definition line from either of the two dropdown lists Project variables 

or Modifiers. Click Insert to insert the item in the template field. The 
Project variables are enclosed by <>'s (e.g. <My Project Variable) while 

the Modifiers are enclosed by square brackets (e.g. [My Modifier]). 
Remember to click Close Entry when you have finished composing a 

Modifier entry. 
 

Format line - When the template is finished, click Format Line command 
button to see how the information is displayed. In case you want to make 

changes, you can either delete the whole line by clicking Clear Template 
or move the cursor to the point of correction and make the changes from 

the keyboard. Note that Project variables enclosed by slashes are 
replaced by the relevant information extracted from the project whereas 

Modifiers remain unaltered. 

 
Build definition lines - When you are satisfied with the template, first click 

Unlock Line and then the Build Def Lines command button to store FastA 
definition lines in all sequence headers.  

 
As for all SEQtools functions changes and/or editorial changes are not 

stored until the project is saved. Closing the project without saving it 
causes all changes to be canceled. 

 
Template for a FastA definition line. 
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Formatted definition line. Note that empty project values are not included 

in the definition lien. 
 

 

Form for entering User Text (the same for all definition lines). 

 

 

Form for extraction of header information to be included in the definition 

lines. The values depend on header information for each sequence. 
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4.11.7 calculators 

A Simple dna and math calculators. 

 
 

4.11.7.1 DNA concentration calculator - Utility for calculation of 
molecular weight of DNA molecules. Enter the number of base pairs and 

either the amount in nanograms or number of pmoles and press the 

Calculate command button. 
 

Single/double stranded DNA - Click SS to perform calculations on single 
stranded DNA or DS for double strand calculations. 

 
Nanograms - If the last entry is the number of nanograms, the 

corresponding number of pmoles is calculated. 
 

Pmoles - If the number of pmoles is the last entry, the corresponding 
number of nanograms is calculated. 

Output: 

• Number of molecules 
• Number of termini 

• pmoles of termini 
• Mw of DNA 
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Constants: 

• Avogadros number = 6.022 x 10 e23 [molecules/mole] 

• A = 331.20 [g/mole] 
• C = 307.20 [g/mole] 

• G = 347.20 [g/mole] 
• T = 322.20 [g/mole] 

• N = 326.95 [g/mole] 
• Average mw of base pair = 2 x 326.95 - 2 x 18 = 617.9 [g/mole] 

 
 
4.11.7.2 Math calculator - Simple mathematical calculator. 
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4.11.8 create files 

Functions for creation and processing of different types of data files 
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4.11.8.1 Batch translation - Function for translation all nucleotide 

sequences in a project into protein. The options for translation is shown in 
the screenshot of the form. The generated protein sequence files can be 

saved after creation is accepted by the user. 
 

 
 
4.11.8.2 EST submission to Genbank - A complex utility for creating a 

multi-sequence file for submission of EST sequences to Genbank. The file 
includes the four TYPE files (Pub, Lib, Cont and EST) required for 

submission. Each of the files is composed by adding information to one of 
four templates (Publication Form, Library Form, Contact Form and EST 

sequence Form) containing all valid fields for that particular TYPE file. 
 

The EST template furthermore lets you insert information retrieved from 
the sequences loaded into the current SEQtools project. Project variables 

are selected from a dropdown list and inserted by clicking the Insert 

command button. 
 

When each page of the template is finished, click the Verify Form 
command button to check if the entry is correct and to convert it to the 

final TYPE text, leaving out empty fields. Obligatory fields are marked with 
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a leading underscore in the templates and fields for which information can 

be retrieved from the project with a leading star (some fields in the EST 
template marked with a star are also obligatory). 

 
When all four template tabs are finished, the submission file - consisting 

of a Publication record, a Library record,  a Contact record and one EST 
record for each sequence - is assembled by clicking Build All. The 

submission file can be viewed by clicking View All and saved by clicking 
Save. 

 
When the file is saved, a submission Template file (with the extension tpl) 

is also saved in the same directory. The *.tpl file can be used to retrieve 
the information included in submission and can be used for submitting 

updates to the original submission. 
 

Note that this requires that the exact same sequences with their headers 

are available to the function in the current project. 
 

After completing the submission file send it attached to an e-mail to 
Genbank at batch_sub@ncbi.nlm.nih.gov. Further information can be 

obtained from NCBI. 
 

The EST Sequence Form of the submission utility. Values in fields in red 
are to be provided by project sequences and their headers. 
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The final submission form, General information section. 

 

 

The final submission form, showing a part of the individual EST records 

section. 
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4.11.8.3 Sequence list, tab-delimited - This function is used to create 
and save a tab-delimited list of project sequences. Clicking the Build 

command button causes the function to scan the displayed project 
sequence list for available information. Available items are listed each 

with a checkbox. Information to be included in the tab-delimited list is the 
simply checked in the list. Click Save when you are done. 
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The selected items displayed in the View tab of the form. 
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4.11.8.4 Multi-record file parser - This user configurable text parser is 

described under the Special menu. 
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4.12 SPECIAL MENU 

1. 4.12.1  about special functions (general comments) 
2. 4.12.2  SAGE programs (serial analysis of gene expression) 

1. 4.12.2.1    extraction of sage tags 

2. 4.12.2.2    sage tools 
3. 4.12.2.3    expression analysis 

4. 4.12.2.4    sage tag search function 
3. 4.12.3  micro array tools (oligonucleotide based microarrays) 

1. 4.12.3.1    microtiter plate index files 
2. 4.12.3.2    micro array design function 

4. 4.12.4  multi-record text file parser 

4.12.1 about special functions 

The Special functions menu include two sets of functions for analyses of 

gene expression: (1) The SAGE (serial analysis of gene expression) 
method basically relies on counting the number of mRNA molecules for 

each expressed gene. The SAGE method does not require any knowledge 
about the genes and may therefore be used to quantify expression of new 

genes as well as of known genes. (2) The micro array method on the 
other hand requires previous knowledge of the genes to be analyzed. The 

functions described below for micro array expression analysis are 
designed for oligonucleotide based custom designed microarrays. 

 

 

4.12.2 SAGE programs 

The SAGE programs include three functions for extraction, processing and 
analyzing sage tags. In addition a search function for searching project 
sequences for sage tag sequences. 
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The SEQtools SAGE programs were originally developed to characterize 

the Blumeria graminis genome and its expression patterns at different 
time points during spore germination as described in the two papers 

below. You can read more about the SAGE method at the SAGE 
homepage. 

  

 4.12.2.1 Extraction of sage tags - This form includes three programs 

for extracting SAGE tags from various types of sequence files: (1) 
Genbank files, (2) sequences included in a SEQtools project and (3) Ditag 

sequence files contained in a project. In addition there is one program for 
creating SAGEmap files. 

 
Extract from Genbank - This function extracts SAGE tags from a 

formatted and trimmed Genbank file with the extension *.tgf or *.ngf. 

The SAGE tags are extracted by the following criteria: The sequence is 
searched within the 2500 3' most characters (in cases where the 

sequence is longer) until the Anchor site closest to the 3' end is located. 
Then a SAGE tag of the specified length is extracted. When all sequences 

have been extracted, the tag list is processed including duplicate tags in 
the first occurrence of the tag as illustrated in the example file shown 

below. 
 

You can limit extraction to sequences that include a polyA tail or extract 
all sequences. Sequences with a leading 5' polyT region are always 

complemented if the number of leading T's exceed that specified by the 
user. 

 
It is possible to generate A SAGEmap reliable mapping file (*.smf) for tag 

identification simultaneously with the extraction of tags.   

 
Note that the user defined tag length does not include the length of the 

anchor sequence, usually 4 bases. The extension of the SAGE tag file is 
*.stf (sage tag file). 

 
Also note that you can build a Genbank file yourself without first loading 

the sequences into a project. Just collect the sequences in the same 

(1) Thomas, S.W., Glaring, M.A., Rasmussen, S.W., Kinane, J.T. and 

Oliver, R.P. Transcript profiling during development of the obligate 
plant pathogen Blumeria graminis using serial analysis of gene 

expression (SAGE). Mol. Plant-Microbe Interact. 15, 847-856, 2002 

(2) Thomas, S.W., Rasmussen, S.W., Glaring, M.A., Rouster, J.A., 

Christiansen, S.K. and Oliver, R.P. Gene identification in the obligate 
fungal pathogen Blumeria graminis by expressed sequence tag 

analysis. Fungal Genet. Biol. 33, 195-211, 2001 
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directory and use the Multi-sequence Functions to build the Genbank 

multi-sequence file. This feature allows you to build very large tag files 
without having to load the sequences into a project. 

 
Extract from current project - This function works in the same way as the 

Extract from Genbank function except that the sequences to be extracted 
must be loaded into a SEQtools project before they can be extracted. 

 
In addition to the tag file (*.stf), this function produces two more files, 

one (*.lst) including a list of sequences not yielding a SAGE tag and a 
second file (*.psg) which can be used to open a project including all 

sequences yielding a SAGE tag. 
 

You can limit extraction to sequences that include a polyA tail or extract 
all sequences. Sequences with a leading 5' polyT region are always 

complemented if the number of leading T's exceed that specified by the 

user. 
 

It is possible to generate A SAGEmap reliable mapping file (*.smf) for tag 
identification simultaneously with the extraction of tags. As the mapping 

information is retrieved from the sequence headers, this only works if the 
sequences are annotated. 

 
Note that the user defined tag length does not include the length of the 

anchor sequence, usually 4 bases. The extension of the SAGE tag file is 
*.stf (sage tag file). 

 
Extract from Ditag-sequences - Before extraction, the ditag sequences 

must be loaded into a SEQtools project and a master ditagfile (*.dtf) must 
either be created (empty) or an existing ditag list opened. You also have 

to enter an expected maximum length of a ditag (2 x anchor length + 2 x 

tag length + a few more to allow for the variation of the type II enzyme) 
and select a file name for the SAGE tag file. 

 
Starting at the 5' end of each sequence in the project, a region delimited 

by two anchor sequences is isolated. Then the length of the ditag is 
checked to see if two full length tags can be extracted and if the ditag is 

shorter than or equal to the specified maximum length.  
 

If these checks are passed, the ditag sequence is compared to ditags in 
the master list containing all previously extracted ditags and rejected if it 

is already in the list. If this check is also passed, the left and right tags 
are isolated. The downstream tag is converted to its complement. If the 

tags are free of N's they are included in the raw tag list. 
 

When all ditag files of the project have been extracted, a 

unique/processed SAGE tag list is constructed. The number of copies of 
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each unique tag is recorded and the processed tag list is saved as a *.stf 

file. The *.stf file is sorted according to the number of tags. The updated 
master ditag list is also saved as a *.dtf file which includes all unique 

ditag sequences and their length. 
 

Format of Sage Tag File (*.stf): The file contains a text header including 
the information indicated in the example below and a tag list where each 

line includes the tag sequence (without the anchor), the number of times 
the tag was found and the origin of the tag (clone name for tags extracted 

from sequences in a project or accession number for non-SEQtools 
generated Genbank multi-sequence files). The maximum length of the 

origin field is 12 characters. Excess characters are truncated without 
warning. The origin information is not recorded for tags extracted from 

ditag sequences.  
 

The header and the tag list are separated by the standard SEQtools 

divider: CR+LF + .. + CR+LF. The fields (= words) in each record (= line) 
are separated by tabs, chr(9). Records are separated by CR + LF. 

 
File types generated by the SAGE extract function: 

 
MTF - Minimal sage Tag File (NCBI): Is a plain text file including the tag 

sequence (without the anchor) and the number of times the tag was 
found. The tags are sorted alphabetically. The fields (= words) in each 

record (= line) are separated by tabs. The same format is used by NCBI 
for downloadable sage data files. 

 
SMF - Sage Mapping File (NCBI): Is a plain text file including the tag 

sequence, a clone/accession number and a gene name derived from a 
gene bank multi-sequence file or from the headers of sequences 

contained in a project. The fields (= words) in each record (= line) are 

separated by tabs. The same format is used by NCBI for downloadable 
SAGEmap reliable mapping files. 

 
DTF - sage DiTag File: Contains a header including the information 

indicated in the example below and a Ditag list including the ditag 
sequence and length. The header and the ditag list is separated by the 

standard SEQtools divider: CR+LF + .. + CR+LC. The fields (= words) in 
each record (= line) are separated by tabs, chr(9). Records are separated 

by CR + LF. 
 

LST - LiST file: A plain text file to be viewed with a text editor. 
 

PSP - Project Load Path file: Contains the full paths (to where the files 
were loaded from) of all files/sequences yielding a sage tag. This file can 

be read by SEQtools to load the referred files into a project. 
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An example of a STF file: 

 PROJECT  Tags extracted from GENBANK.FGF 

 FILE NAME  Tags from genbank.stf 
 DATE   12-02-98    23:09:51 

 ANCHOR  CATG 
 LENGTH  10 

 NUMBER  516 
 DUPLICATES  608 

 .. 
 GGATTCATGG 47 ;X234765 ;D244765 ;H986556 

 ACGATTCGTT 43 ;R223545 ;A445678 

Screenshot of the Extract SAGE tag form. The options under the different 
tabs are explained in the text section above. 
 

 
 
 

4.12.2.2 Sage tools - This form contains a collection of functions for 
modifying and comparing SAGE (sequence analysis of gene expression) 

tags files. 
 

The SAGE analysis of gene expression is a very powerful method of 
studying gene expression, especially if you are interested in differences in 

expression patterns at two different stages of the cell cycle. When SAGE 
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tag files are available for both stages, the functions included here allows 

you to find genes expressed at either or both stages. The query server 
makes it easy to retrieve the data base entries for relevant genes. 

 
All functions included in the SAGE tools require that two SAGE files are 

loaded and that the two files are compatible, i.e. that anchors and tag 
length are the same for both tag files. Processed files can be 

saved/exported in default SEQtools format (*.stf) or NCBI minimal format 
(*.mtf). 

 
Processed files, i.e. where the numbers of tags are replaced by 

frequencies or percentages, cannot be used in further comparisons but 
are intended only for searching sequences loaded into SEQtools projects. 

The default extensions for processed tag files are *.pst. 
 

File menu - The file menu contains the usual items. SAGE tag files can be 

loaded/imported and saved/exported in default SEQtools format (*.stf) or 
in NCBI minimal format (*.mtf).  

 
Edit menu - enables you to save the histogram as a graph file. The 

histograms can be copied to the clipboard either as a *.bmp or a *.wmf 
image. 

 
Function menu - The Function menu contains five functions processing 

pairs of SAGE tag files in various ways. If a function does not return a 
result a an error message is returned. This may for example occur if you 

attempt to subtract a two tag lists and all entries in one of them are 
included in the other - or if you look for common tags between two files 

that do not have any tags in common. 
 

If common tags of two SAGE files have been extracted with the Common 

in first and last function, the frequency/percentage is calculated 
separately for the contribution of each of the two original files and the 

result shown in the histogram in different colors. 
 

Graph options - This allows you to select how many sage tags to include 
in the graphics display or when printing the distribution histogram. 

Below are screenshots showing the content of the different tabs of the 

SAGE tools form. 
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Histogram displaying the distribution of tag frequencies for the first tag 

file. 
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Distribution of tags present in both loaded tag files. 

 

 

Data tab for the histogram displayed above (tags present in both loaded 
tag files). 
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Data table for  tab for processed tag files shown above. (P Num = total 

number of tag present in both tag files; P TPM =  tags per million for total 
tags present in both tag files; F Num = number of tags in first tag file; F 

TPM = tags per million for first tag file; L Num = number of tags in Last 
tag file; L TPM = tags per million for last tag file) 

 

 

SAGEmap reliable mapping file - In order to take advantage of the 

annotation options for the tag source sequences you have to 
create/download a SAGEmap (*.smf) file and use the data in this file to 

identify the genes corresponding to sage tags as described above under 
the Extract SAGE Tags function. 

 
Basically, a mapping file is a tab delimited ASCII file containing the tag 

sequence, a unique gene identifier/clone name and an annotation 
line/gene name. 

 
Mapping files for several organisms can be downloaded from NCBI for 

Homo, mouse, rat and S. cerevisiae. In cases where you work on a 
different organism a mapping file can be constructed on the basis of an 

annotated EST library or from a FastA multi-sequence file. SEQtools 

includes functions to create SAGEmaps from both data types. 
 

In case a FastA multi-sequence file is not available it can be generated 
with the Local Database Function. 
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Example of a SAGEmap reliable mapping file 

AAAAAAAAAA C00196-R heat shock protein 70 [Trichophyton rubrum] 2e-16 
AAAAAAAAAA C00224-F protein associated with DNA helicase/prim 6.0 

AAAAAAAAAA C00280-R hypothetical protein Rv2052c [Mycobacte 0.37 
AAAAAAAAAA C00822-M HYPOTHETICAL 24.1 KD PROTEIN C17A5.08 IN CH 9e-19 
AAAAAAAAAA C01407-R No description list for sequence C01407-R. 

AAAAAAAAAA C0A12-1R mucin, tracheobronchial - dog >gi|402558|emb|CAA4891 8.5 
AAAAAAAAAA D00131-F No description list for sequence D00131-F. 
AAAAAAAAAA D00369-F 64aa long hypothetical protein [Aerop 0.008 
AAAAAAAAAA D00428-R No description list for sequence D00428-R. 

AAAAAAAAAA D00470-M No description list for sequence D00470-M. 
AAAAAAAAAA D00581-F HEAT SHOCK PROTEIN HSP1 (65 KD IGE-BINDING 6e-44 
AAAAAAAAAA D00599-M No description list for sequence D00599-M. 

AAAAAAAAAA D00620-F TYPE II DNA MODIFICATION ENZYME (METHYLTRA 0.36 
AAAAAAAAAA D00762-M HYPOTHETICAL 37.2 KD PROTEIN IN ALG9-RAP1 I 6e-04 
AAAAAAAAAA D00818-F No description list for sequence D00818-F. 
AAAAAAAAAA D00837-F PUTATIVE GLUCOSYLTRANSFERASE C08H9.3 >gi|38 6.3 

AAAAAAAAAA D00940-M endonuclease [Magnaporthe grisea] 5e-53 
AAAAAAAAAA D01107-M A2-5a orf23; hypothetical protein [Ba 1.7 
AAAAAAAAAA D01268-F GTP-binding protein ypt5 - fission yeast (Schizosacc 2e-12 
AAAAAAAAAA D01294-M glyocprotein [Vesicular stomatitis virus] 9.5 

AAAAATCTTG D00950-M LONG-CHAIN-FATTY-ACID--COA LIGASE 3 (LONG-C 7e-10 

   

The SAGEmap list includes the tag sequence, a description of the gene 
with the tag sequence in the 3'-most end of the sequence and the expect 
value for the match. 

 
4.12.2.3 Expression analysis - This utility allows you to compare up to 

six SAGE tag files generated with the same anchor sequence. The result 
of the comparison is displayed either as a histogram or as data text 

output in the form of tables of frequencies or origin of tags. The frequency 
tables are formatted so they can be imported into a spread sheet for 

further processing. The function works with SAGE tag files generated by 

SEQtools, extension *.stf (Sage Tag File) or tag files imported in *.mtf 
format (NCBI). 

 
This function furthermore enables you to analyze if tags included in a 

particular tag file are more or less frequent than the tags contained in the 
first file loaded. In other words to see if a given gene - represented by a 

SAGE tag - is up- or down regulated relative to its expression at the stage 
where the SAGE tags in file 1 were collected. 

 
The options included with this function may seem complicated but with a 

bit of patience and practicing you will realise that the function is a quite 
powerful tool in analyzing the large amount of data produced by the SAGE 

procedure. 
 

In order to take advantage of the annotation options you have to 

create/download a SAGEmap (*.smf) and use the data in this file to 
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identify the genes corresponding to sage tags as described under Extract 

sage tags. 
 

The Analysis menu: 
 

Building the Final tag list - The comparison is performed in the following 
way: File 1 is loaded and is used to create a Final Processed file which 

includes the entire content of file 1. When the next file is loaded, the main 
file is updated to include only SAGE tags which are also included in file 2. 

Following tag files are compared in the same way to the final tag file. This 
implies that the final tag file, after loading the last file contains SAGE tags 

common to all loaded tag files. The main tag file is then sorted by the 
sum of frequencies for each tag. 

 
Data sets - Include all data sets - This implies that also tags which are 

NOT present in all loaded tag files are included in the final file and are 

displayed in the histogram and included in the data lists. 
 

Reject incomplete data sets - In this case only tags which are present in 
ALL loaded tag files are included in the final file and are displayed in the 

histogram and included in the data lists. (default) 
 

Sort order - With this option you can select which of the loaded tag files 
are used for sorting the final data. The selected sort option applies both to 

the histogram and to the data lists.  
 

Expression analysis - The expression analysis subtracts the selected file 
(2 - 6) from the first tag file loaded. Positive values implies down-

regulation, negative values up-regulation. The differences are either 
sorted and displayed by their numeric values, Absolute frequencies, or 

according to their true value, Ordered frequencies. 

 
The Graph menu: 

 
Tags per page - Sets the number of data sets displayed per histogram 

page. The Page Up, Page Down, Home and End control the navigation 
between pages. When expression analyses are displayed, the first time 

Home or End are pressed, the display moves to the border between 
positive and negative differences. The second time, the it jumps all the 

way home or to the end. The range of data currently displayed is shown 
in the field to the right. 

 
Axes - In this menu you can select whether the histogram is displayed 

with a fixed scale of the Y-axis or if the Y-axis scale is adjusted for each 
page of the histogram. The latter option is convenient when you want to 

enlarge small differences between tag frequencies. The Labels option 

allows you to turn on or off labels on the X-axis.  
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Color pattern - Allow you to select a number of color patterns for the 
histogram display. The options in the Visual Basic graph engine are not 

overwhelming but it is possible to get different colors for all six data sets. 
 

Graph title - Makes it possible to change the font size within limited 
ranges. The graph engine makes sure that the selected size matches the 

displayed histogram - and adjusts if necessary. You can also enter a title 
for the histogram. 

 
The Data menu: 

 
Summary loaded files - Lists a summary of all loaded SAGE tag files 

 
Frequency, histogram/entire file - Builds a compressed tag list either for 

the range currently displayed or for the entire data set. The data can be 

loaded into a spreadsheet for further processing. 
 

Origin, histogram/entire file - Builds an annotated tag list if sequence 
header data are available. The list either includes the range currently 

displayed or the entire data set. 
 

Differential expression, histogram/entire file - Builds an annotated list 
containing frequencies for tag file 1 and the difference between file1 and 

the selected tag file. Down-regulated tags/genes are denoted by ( - ) and 
up-regulated by ( + ). With the cutoff option in the data display menu, 

the number of data sets can be reduced. 
 

Data display options -  

Clone names - Uses clone names in the data lists instead of sequence 

header lines 
Gene names - retrieved from a SAGEmap file 

Clone and Gene name - retrieved from a SAGEmap file 
Cut off limit - This option is only active when tag files are compared 

(expression analysis). Truncates the data list according to the set cut off 
value. The limit is calculates as a percentage (5, 10, 15, 20, 25, 30) of 

the numerically shortest Y-axis. Include all, sets the cut off value to zero, 
i.e. no limit. The cutoff limit is based on statistical analyses of the tag 

frequencies in the two profiles.  
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Graphical display of a comparative sage tag histogram. 

 

 

An example of the data display for a SAGE tag expression analysis 
(tag file 1 minus tag file 3). 

 

 

 

 
4.12.2.4 SAGE tag search function - The SAGE search function is 
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designed to search all sequence files currently loaded into a SEQtools 

project with a list of SAGE tags. 
 

Before starting a search, a SAGE tag data file *.stf or *.ptf must be 
loaded into the search program. Prior to opening the data file, enter the 

length of the SAGE tags. All tag sequences are validated (only ACGT are 
allowed) and compared to the specified length. Tags of different length 

and/or containing illegal characters are rejected during loading the SAGE 
tag data file. 

 
If you want to include a part or all of the anchor sequence in the search, 

type the bases you want to include in the Anchor sequence field. 
 

Select in Strand if you want to search both strands, the Watson or the 
Crick strand of the sequences in the project. 

 

The output of the search is displayed on a separate form and includes the 
sequence name, the tag number, ID and sequence. The anchor sequence 

is separated from the tag sequence by a / . In the View menu of the 
result form you can specify a header line (line 1 to 5) and instead see the 

result as a list of the specified header lines. 
 

Double clicking a line in the results list retrieves the header of the 
corresponding sequence. Closing the header form brings back the SAGE 

analysis result list. Messages to the user are displayed in the infoline at 
the bottom of the analysis form. 
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4.12.3 micro array tools 

The functions described below are designed to construct and handle 
oligonucleotide based micro array analyses of gene expression. The first 

function is used to index oligonucleotides stored in 8 x 12 well microtiter 
plates (MTP). The second function is used to build micro array project files 

(MPF) combining from sets of oligonucleotides in microtiter plates. 
 

The first function is designed to assist you in creating an index file 
(MicroTiter Plate, MTP) for sequences/oligonucleotides contained in a 96-

well microtiter plate. 

 

 
 

4.12.3.1 Microtiter plate index files - The microtiter plate file (MTP) is 
a multi-sequence file containing 96 individual oligonucleotides and their 

annotation. Each sequence (or blank) is assigned an unique position 
identifier, A01 - H12, corresponding to its location in a 96-well microtiter 

plate. 

 
Nucleotide sequences with or without annotation must be loaded into a 

SEQtools project to be included in the MTP file. If more than 96 sequences 
are loaded into the project, only the first 96 are automatically included in 

the MTP file. Loading less than 96 sequences into the project causes the 
function to add blanks (sequences consisting of a single N and no 

annotation) to reach a total of 96 entries. 
 

Follow the steps below to create a new MTP file from a collection of 
sequence or primer files. 

 
How to create a MTP file - Load the files you wish to include in the MTP 

file into a normal nucleotide SEQtools project. 
You can load more that the required 96 files or less if you prefer to 

include blanks - or if you do not want to fill the microtiter plate 

completely. 
 

If you load a large number of sequences into SEQtools, it is sometimes 
preferable to isolate a smaller sub-group by selecting some of the files 

and launch a new instance of SEQtools including only the selected files. 
 

In the next step you assign a sequence or a blank to each of the 96 
microtiter plate positions: 
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• - Open the Special/Microtiter Plate Indexer and click the Create/Edit 

MTP File tab. 
• - All microtiter plate 96 positions are already filled with blanks. 

• - Navigate in the main SEQtools Editor or the Header form to the 
sequence you wish to insert. 

• - Highlight the insert position in the MTP list by clicking the line. 
• - Click Replace Entry to insert the selected sequence at the specified 

MTP location. 
• - Double-clicking a line containing an entry removes the name from 

the list by inserting a blank. 
• - If project contains the sequences you wish to include in the 

correct order you can just click Load  
     From Project to automatically fill the MTP list. 

• - When you are done, fill out the MTP file header and save the MTP 
file, File/Save/Microtiter Plate File. 

A 6-digit checksum - is generated after joining, in the correct order, all 
nucleotide sequences included in the MTP file. When the same file is 

opened, the checksum is re-calculated and the two checksums compared. 
If the checksums differ - indicating that the MTP file has been altered 

since it was saved - a warning is issued. 
 

FastA definition lines - When a MTP file is imported into a micro array 
layout design project, the information included in the ImaGene GeneID 

file is retrieved from the fasta definition lines of the sequences contained 
in the MTP file. To ensure correct parsing of the fasta definition line it is 

essential that it is correctly formatted. 

 
Make sure that the definition lines contains the following number of words 

in the correct order. Each word must be separated by a single space. The 
last part of the definition line, the gene description may contain additional 

words, but must be the last of the fasta definition line. The FastA 
definition line should contain the following information: 

• - word 1 = accession number 

• - word 2 = primer ID 
• - word 3 = plate number 

• - word 4 = position in microtiter plate + position in micro array 

(e.g.,pos:A01-1.1.1.1) 
• - word 5 = species name 

• - word 6 = description 

Currently only word 1, word 2 and word 6 are used by the micro array 
layout design function. In cases where information for a certain word is 

missing, just use a spacer (a dash) to maintain the correct number of 
words. The FastA definition line editor can be used to compose correctly 

formatted definition lines.  
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Examples: 

  

 >NM_56736  PQGTHIL.SEQ #2 pos:A2-1-2-4-5 Rat 
Glyceraldehyde-3-phosphate dehydrogenase 

 >NM_56736 PQGTHIL.SEQ #2 pos:A2-1-2-4-5  
 >None     PrimerID - - - Rat Glyceraldehyde-3-phosphate 

dehydrogenase 
 >NM_56736 - - - - Rat Glyceraldehyde-3-phosphate 

dehydrogenase  
    

The MTP multi-sequence file includes the full nucleotide sequence and 
annotation for each included sequence. The MTP file header (separated 

from the body by a "&&" divider) contains the following information: 

• - Title of the microtiter plate 
• - A user defined plate ID 

• - Name of the author 

• - Date and time of creation 
• - Number of entries (processed entries) 

• - Number of blanks 
• - Number of duplicates 

• - A unique checksum for the sequence content of the MTP file 

Existing MTP files can be loaded into SEQtools either as standard multi-
sequence (MS) files via the normal File/Open... functions or by the 

Special/Micro array Tools/Microtiter Plate Indexing function. Only in the 
latter case is the MTP file header read and displayed by SEQtools. 

 

Opening MTP files - Only correctly formatted MTP files with a *.mtp file 
extension can be opened by this function. 

 
When an existing MTP file is opened, the content of the file header is 

displayed in the various fields and the sequence checksum is calculated 
and compared to that generated when the file was saved. 

 
The sequences and their headers contained in the MTP file are loaded into 

SEQtools in the same order as they were saved. The file list in the 
Create/Edit MTP File tab is updated with the new information. 

 
Editing MTP files - Remember that only files contained a SEQtools project 

can be added to a MTP file. If the sequence you wish to include in your 
MTP file is not a member of the current project you can append new files 

to an existing SEQtools project using File/Add Files To Project. Also note 

that the number of sequences in an MTP file is fixed to 96. This implies 
that inserting a sequence or a blank at same time removes another 

sequence or blank. 
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Undo - The last 10 operations can un-done by clicking Undo. 
 

Replace - Highlight the sequence you want to replace in the MTP list. 
Navigate in the SEQtools project to the sequence you wish to use as the 

replacement. Click Replace Entry. 
 

Insert - Make sure that the last sequence in MTP list is dispensable. 
Highlight the position below the insertion point. Down-Shift the MTP list 

from the insertion point to create a blank position. Replace the blank 
position with the sequence from the current project to be inserted. 

 
Remove - Double-click an entry to replace it with a blank without altering 

the coordinates of the remaining entries of the MTP list. 
 

Up-shift list - Move all entries downstream of and including the 

highlighted entry one line up. Adds a blank at the end of the MTP list to 
maintain the fixed length of 96 entries. Warning: the coordinates of all 

entries downstream of the removed entry are changed by this operation. 
 

Down-shift list - Move all entries downstream of and including the 
highlighted entry one line down. Inserts a blank at the free line to 

maintain the fixed length of 96 entries. Warning: the coordinates of all 
entries downstream of the removed entry are changed by this operation. 

 
Clear all - Removes all entries from the MTP list. 

 
Load from project - Loads sequences contained in the current SEQtools 

project into the MTP list. Loading starts with the first sequence in the 
project and ends with sequence 96. Blanks are added as required to 

maintain a fixed list length of 96. Warning: This operation cannot be un-

done. 
 

Remember to save the MTP file after editing. 
 

Checksum - A 6-digit checksum is generated after joining, in the correct 
order, all nucleotide sequences included in the MTP file. When the same 

file is opened, the checksum is recalculated and the two checksums 
compared. If the two checksums differ - indicating that the MTP file has 

been altered since it was saved - a warning is issued. 

Screenshots of the different tabs of the Microtiter Indexing form are 

shown below: 
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The microtiter plate Create/Edit tab. 

 

 

The MTP file header editor. 
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The microtiter plate template. 

 

 

The microtiter plate sequence list. 
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4.12.3.2 Micro array design function - This function includes facilities 

to combine multiple microtiter plate files into a micro array layout project. 
 

The function generates, on the basis of the selected MTP files a GeneID 
file containing the coordinates to each spot in the micro array, the 

accession number of the gene from which the oligo nucleotide was 
derived and a short description of the gene. The GeneID file can be read 

by the ImaGene image analyzer. 
 

IMPORTANT: In calculating spot coordinates it is assumed that the micro 
array will be printed by a Affymetrix GMS 417 arrayer equipped with a 4-

pin printing head having a pin-to-pin distance of 9 mm. The layout should 
be generated by the GMS 417 "AutoGenerate Tool" in "Horizontal" mode 

with the "Dot Spacing" for both X and Y set to the value used by SEQtools 
to generate the micro array layout. 

 

WARNING: Setting the dot center-to-center distance in the GMS 417 
arrayer to a different value than the one used to generate the layout in 

SEQtools may result in a different number of plates per row before 
wrapping to the next row. Obviously this will disrupt the association 

between dot coordinates and Gene ID. 
 

How to create a MPF file: 

- On the Micro array Design tab use the Open MTP File command button 
to select the microtiter plate files (MTP files) you wish to include in the 

micro array. 

- If you want to remove a MTP file from the list just double-click it. 

- Then click Load Selected to create a new SEQtools project containing the 

selected sequences. 

- You can view the headers of the loaded MTP files on the MTP File 

Legend(s) tab. 

- Click Build Micro array, ImaGene File #1 or ImaGene File #2 to compose 
an index file including information from all MTP files comprising the micro 

array project. 

- Use File/Save As/... to save the micro array index files in the specified 

format. 

Gene descriptions, Options - The two menu items under the Options 
menu allow you to choose a blast header section to supply the 

information for gene descriptions. The second menu item, brings you to 
description line formatting options. Remember to rebuild the micro array 

or imagene file to refresh the content after altering gene descriptions. 
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Save micro array projects - Once the micro array project is completed you 
can save the entire project as a multi-sequence Micro array Project File 

(*.mpf) 
 

Save ImaGene GeneID file - Data files for the ImaGene image analyzer 
can be saved in either of the two formats (#1, #2) described in the 

ImaGene manual. 
 

Open micro array projects - Micro array project files, *.mpf, can then be 
re-opened at a later stage for editing or inspection of the data associated 

with the micro array layout. 
 

About printing - Project reports consist of a project page followed by one 
page per MTP file containing in a 12 x 8 format the file names of the 96 

sequences contained in the MTP file. 

 
Displayed micro array list - This print option simply prints the currently 

displayed ImaGene List / sequence list. 
 

WARNING: Keep in mind that micro array layout project files (*.mpf) can 
be very large 

Screenshot of the Micro array design tab illustrating how a project is - in 

this case - composed from five microtiter plates. 
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The Micro array oligonucleotide project file. 

 

 

The micro array project file legend displaying the header for MTP file 

RA_plate#001. Clicking Next or Previous navigates between the five 

microtiter plates. 
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The micro array project header tab. 

 

 

As described above there is an intimate relationship between micro array 
design and the SEQtools project containing the nucleotide sequences for 

all oligonucleotides used in the micro array project. The main advantage 
is that the search/annotation facilities of SEQtools can be utilized to 

verify/characterize the oligonucleotides to be used in the micro array. 
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The project sequence list for a micro array SEQtools project. 

 

 

Using blast search results for the sequence list provides an easy way of 
getting an overview of the involved genes used to construct the micro 

array.  
 

 

 

4.12.4 multi-record text file parser 

This utility is designed for extraction of defined records from a 

downloaded multi-record text file, for example from a Locus Link search. 
 

The saved result text file from a search like this is not immediately suited 
for retrieval of the sequences found by the search. By using the SEQtools 

parser is possible to extract up to 8 lines from each record of the original 
text file and combine them into a new well defined multi-record file. 

 
By using the "Mandatory" option the parsed text file can be filtered to 

exclude  incomplete records. Using this parser makes it easy to build an 
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input file for batch Entrez retrieval of the actual nucleotide or protein 

sequence records. 
 

Parsing record lines, Record Mode - Parsing with these settings extracts 
records consisting of the LOCUSID: line + information from NM: and NP: 

lines. The Line ID keys are removed and only records containing all three 
lines are included in the parsed file. 

 
Parsing individual lines, Line Mode - With the setting illustrated above 

each of the first words of all lines in the raw text file is removed and all 
lines are truncated after character 60. 

 
Three steps in converting a downloaded flatfile from Locus link to a 

accession number list suitable for batch retrieving sequence records from 
Entrez are: 

- Download the locus link flatfile 
- LOCUSID lines extracted with record parser 

- Trimmed accession number lines with line parser  
 

Parsing with these settings extracts records consisting of the LOCUSID: 
line and information from NM: and NP: lines. The Line ID keys are 

removed and only records containing all three lines are included in the 
parsed file 

 

 

With the setting shown above each the first word of all lines in the raw 

text file is removed and all lines are truncated after character 60. The 
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three steps in converting a downloaded flatfile from Locus link to a 

accession number list suitable for batch retrieving sequence records from 
Entrez are illustrated below. 

 

 

Original downloaded locus link flatfile. 
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LOCUSID lines extracted with parser in Record mode. 

 

 

Trimmed accession number lines with parser in line mode. 

 

 

 

 



 240 

4.13 WWW MENU 

1. 4.13.1  about web resources 

2. 4.13.2  populating the URL list 

4.13.1 about web resources 

It is convenient to have easy access to often used resources on the 

Internet.  This launch menu allow you to specify up to 10 URL's to your 
favorite resources directly from the main SEQtools menu. Needless to say 

that this only works if you are connected to the Internet. 
 

 

 
4.13.2 Populating the url list 

The list of URL's to web resources can be changed in Launch tab of the 
General Settings form. Simply type the URL and the title you wish to use 

for the resource. URL's containing the word NCBI get a NCBI icon on the 
main editor menu while other URL's get a globe. 

 

 


